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Chapter 1
Introduction

Oracle Real-Time Scheduler maps are used by the Scheduler, a component of the Oracle Real-

Time Scheduler application, to obtain travel information and to display places and travel paths in a 
particular geographical region. A map consists of Nodes (geographical locations, etc.) and inter-
node Links for which the direction, distance and travel times are known.

As of this release, you may create output maps in HIP format. HIP format maps can store and 
convey to scheduler information about historical road speeds for the day of week, time of day. 
This information can be obtained from the HERE “Historic Traffic Patterns” product as part of 
the scheduler map file. 

MAL format maps may still be used where time dependent road-speeds are not a requirement.
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Definitions
Map Objectives
The objectives of the map are to provide: 

•  Connectivity (route) information

•  Travel time information

•  Graphical display information

The Map Editor is a map editing utility in which map links can be edited using simple mouse 
operations.

The Links which make up the map data are displayed as lines in the Map Display Window on the 
screen and the Nodes though invisible are always at the end or intersection of Links. The Nodes 
represent geographical positions to which vehicles can travel or the locations of geographical 
features, while the Links represent the travel paths by which the vehicles travel from one Node to 
another.

The Map Editor Display Window can display raster and greyscale map images, such as a picture of 
a topographic map or street directory, concurrently with the Node and Link data. These picture 
image backgrounds, greatly assist in the editing process, and make the geographic relationships of 
the map data more meaningful.

The following chapters describe the Map Editor display, menus, operations and controls while 
giving the reader a clear understanding of how to use Map Editor to edit maps. 

Definitions

Term Definition

Map Editor The Oracle Real-Time Scheduler software which reads 
mapping data from third party providers (like HERE), applies 
edits and writes the resulting maps in a format suitable for 
scheduling. 

Scheduler Oracle Real-Time Scheduler software that uses the maps 
created or edited by Map Editor for travel time estimates to 
calculate the best possible schedules.

Node A geographical location (for example: intersection or bend in 
the road etc.) on a map.

Link A road segment on a map, connecting two nodes and having a 
known direction, distance and speed.

Toll A penalty associated with travel along a certain link. This 
penalty is not associated with the running cost of a vehicle but 
is used to discourage the use of these links.

Base Layer This is the “standard” or “default” map, all other layers 
modify the speeds on this layer. Note that this map is assumed 
to be the fastest of all layers. The “Base Layer” is used to 
calculate travel-times and routes where none of the “Traffic 
Layers” apply. 

Traffic Layer Any layer other than the Base Layer. Adjusts road-speeds for 
specified dates, day-of-week and times. 
Introduction 1-2
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Chapter 2
Display and Controls

This chapter describes the Main Window display, it’s associated permanent panel - the 

Menu Bar, Tool Bar and all the menu options and associated sub windows. It includes:

• The Map Editor Main Window

• Menu Bar

• File Menu

• View Menu

• Windows Menu

• Options Menu

• Operations Menu

• Help Menu

• Tool Bar
Display and Controls 2-1
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The Map Editor Main Window
The Map Editor Main Window
When Map Editor is initiated, an application window is created on the screen that 
consists of a window frame containing a Main Menu Bar, a Toolbox panel and a Map 
Display area.

The map data is displayed in the Map Display Area of the application window. The extent 
of map data being displayed on the Display Area can be controlled by:

• resizing the Main Window

• or adjusting its magnification

The map data is edited by using the mouse to select map Links from the Map Display 
area. The techniques for editing data will be described in detail later in this manual. (See 
“Map Editor Operations” on page 1.)

The Menu Bar allows control of general operations, but does not directly cause any 
change to occur in the map data.

The Map Display
Map Editor can be configured to start up with or without a map. The following image is 
a snapshot of the default Map Editor start up screen.

 

When a map has been loaded, the Links in the map are displayed in the Map Display Area 
as illustrated in the figure below. The Links are displayed as colored straight lines joining 
pairs of Nodes, one Link for each direction along the travel path between them. Link 
colors represent different road speeds. See “Speed Legend” on page 33 for more details 
on map road speed legends.

Menu Bar

Tool Bar

Map Display Area
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The Map Editor Main Window
Note: Nodes are not visible on the Map Editor Display.

Selections
One or more Links can be selected from the displayed Map. This can be done by 
selecting the Modify Map option from the Options menu and then performing Ctrl Left 
Click on the required Link. Please see “Editing Multiple Links at Once” on page 3 for 
more details on selecting map links. 

A selected link can be deselected by redoing a Ctrl Left Click on the link. 

Hovering the mouse cursor over a link will bring the nearest link into focus and will 
highlight it in black, which can then be selected with a Ctrl Left mouse Click. The 
selected links are highlighted in magenta by default.

Selected link highlighted in magenta

Focused link
Hover mouse cursor on the Map will bringhighlighted in black
the nearest link into focus
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The Map Editor Main Window
Positioning the Map
The position of the map in the Map Editor display window can be changed arbitrarily by:

• using the mouse cursor to Shift Left Drag the map to a new location

OR

• pressing the middle mouse button and dragging in the required direction.

Window local menu

Local menu when no links are selected
The Map Editor display features a window local menu with options which can be used to 
customize the map display. This menu can be invoked with a Right Click, anywhere 
within the display area.

In order to select an option from the Map Editor window local menu:

Position the mouse cursor on the required option and Right-click on it.

The window local menu options are outlined in the table below.

Menu Option Description

Zoom In/Out Increase or decrease the map display magnification.

Zoom Reset Resets the map magnification to the minimum.

Print Map Prints the Map displayed on the display area.

Zones If Zone definitions are available, then their display can be 
toggled On or Off within the Map Editor display area.

Raster Map Toggles the Raster Map display On/Off if available.

Greyscale Toggles the Raster Map color display On/Off if available.

Links Toggles the display of links on the Map display On/Off.

Right-click within the Map Editor display
area to invoke the Window Local Menu
Display and Controls 2-4
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The Map Editor Main Window
All the options listed under the Map Editor window local menu are also available from 
the Menus on the Main Menu bars.

Speed Legend Map links are drawn with distinct colors to represent different 
road speeds which can be identified from a Speed legend 
window. 

Map Layer Info Allows to select a Traffic Layer to show road speeds on this 
layer. Map Links are drawn with distinct colors to represent 
different road speeds on a selected Traffic Layer.

Link Info This option can be turned On to pop-up the “Node-Link 
Info" window. This window displays the details of the Link 
nearest to the mouse cursor at any time.

Two-directional Links Toggles the display between single or double links on the Map 
display. This option is effective only while the “Links” option 
is enabled.

Auto Centre This only works when the link is selected in the Link Search 
window. If turned On, automatically positions the Map within 
the display area such that links selected in the Link Search 
window are at its centre.

Modify Map On invoking the window local menu while links are selected, 
an additional menu labelled “Modify Map” is also listed. 
Please see “Editing Multiple Links at Once” on page 3 for 
more details on the Modify Map option. 

Join Connects third party maps loaded into Map Editor by joining 
nodes at the same location.

Check duplicate Links Finds duplicate links in the loaded map and removes them 
before saving to Oracle Real-Time Scheduler format.

Connectivity Checks for Links that are not connected to the selected Link 
and removes them so that the remaining links form a 
connected map.

Compress Links Compresses the map by removing redundant nodes.

Compress Traffic Layers Compresses the original traffic layers provided by the original 
third party traffic information, into layers defined by user. 

Menu Option Description
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The Map Editor Main Window
Local menu while links are selected
On invoking the window local menu while links are selected, an additional menu labelled 
“Modify Map” is also listed. Please see “Editing Multiple Links at Once” on page 3 for 
more details on the “Modify Map” option.

Right-click within the Map Editor display
area to invoke the Window Local Menu

Menu option displayed
only if links are selected
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Menu Bar
Menu Bar
The Menu Bar displays a list of menus from which, either a range of configuration and 
display options can be selected or Sub windows to facilitate specific operations can be 
activated.

Menus
The available menus include the following: 

Each of the menu in the Main Menu Bar are described below. All disabled menu options 
are greyed out by default.

Activating a Menu

METHOD 1
When you Left Click one of the menu names, a further set of options may appear within 
a pull-down menu. 

To make a choice from the pull-down menu, Left Click the mouse pointer over your 
choice. 

To abandon the pull-down menu, move the mouse pointer out of the menu and Left 
Click.

METHOD 2
Alternatively, this operation can be accomplished by a single Left Drag operation — for 
example, activate the menu from the Main Menu Bar with a Left Press (which displays 

Main Menu Bar

Menu Description

File Enables loading, saving, printing of map files and proper 
termination of the Map Editor application. 

View Allows you to control the way a map is displayed by the Map 
Editor such as, controlling the map magnification, displaying 
zones and topographic map images. 

Windows Provides access to the windows like Info Window, Link Info, 
Speed Legend and Map Traffic Layers Info. 

Options Provides map options which can be toggled On or Off. The 
Options enable displaying single or two-way links and Auto 
Centre.

Editing of selected Links can also be enabled from this menu. 

Operations Provides menu items to perform specific map operations like, 
editing zones, performing map checks, compressing maps, 
removing disconnected regions etc. and specifying search 
criteria to search for links. 

Help Displays the version of Map Editor software in use. 
Display and Controls 2-7
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Menu Bar
the pull-down menu), then Left Drag the cursor to the desired option and release the 
mouse button. To abandon the menu, do not release the button while inside the menu, 
but Drag the cursor outside the menu and then release the button. 
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File Menu
File Menu
The File Menu options enable Loading, Saving, Printing and Closing of Map files. The 
File Menu also provides a safe and proper method of terminating the Map Editor 
application. On selection, this option opens a pull-down menu as illustrated below:

 

The File menu pull-down menu has the following options:

Option Description

Load... Activates the configuration window from where you can 
configure and load a new map

Load MAL format... Enables to load a map in the Oracle Real-Time Scheduler 
MAL format

Save MAL format... Enables the currently loaded map to be saved in Oracle Real-
Time Scheduler MAL format

Load HIP format... Enables to load a map in the Oracle Real-Time Scheduler HIP 
format 

Save HIP format... Enables the currently loaded map to be saved in Oracle Real-
Time Scheduler HIP format 

Load Raster... Loads a raster map

Close Raster Unloads the currently used raster map from Map Editor

Print Map Prints the currently loaded map

Edit Config... Allows to create or edit map configuration

Edit Current Speed... Allows to create or edit speed configuration when traffic 
layers are not in use

Quit Closes the Map Editor application
Display and Controls 2-9
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File Menu
Load
Map data from third party map data providers in non-standard format can be loaded into 
Map Editor using the Load option.

After completing the load operation an Info window similar to the one illustrated in the 
image below pops-up displaying the map name and the number of nodes, polypoints and 
links that it is made up of.

To load a vector map for the very first time, select File, Load from the Main Menu. This 
will display the following “configuration” dialog.

You can use this dialog to choose the map format, data and traffic profiles set(s), define 
the data format, configure the filters and traffic layers.

Clicking on the Edit button adjacent to the Configuration option displays the 
corresponding edit dialog. Each configuration item can be saved individually. 

User should only use one option to define link speeds: traffic profiles data or Speed 
Configuration, not both.

Area and Speed Configurations do not depend on data format and are stored in the 
default <configPath> directory. Data Set, Traffic Profiles, Data Format and Filters and 
Traffic Profiles Data and Layers Configurations are stored in the Format specific 
configuration directories such as configPath/MIF, configPath/TAB or configPath/
Shape which are created by Map Editor depending on the selected format. After defining 
all the Configurations, the Master Configuration must be saved by clicking on the Save 
button. A list of all the files created by you are saved in the Master Configuration file.

Note: You cannot Create new Area or Speed Configurations until the 
data has been loaded.

Finally, select the Load button to load the data from the selected configuration file.
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File Menu
The steps to create the Configuration file and to load a map are described in more detail 
in the following sections.

Format

Selecting the Map Data Format
1. Select an appropriate map data format from the drop-down list.

The Map Editor constructs maps that are compatible with Oracle Real-Time Scheduler, 
using commonly available map data formats such as MIF/Shape and TAB.

Configuration Name

Setting the Master Configuration Name
All the saved configurations that are available for the selected map format are listed in the 
Configuration Name pull-down menu.

1. Select New to create the Configuration from scratch, or load an existing Master 
Configuration file by selecting its name from the available list.

Data Set Configuration
The first step in Data Set Configuration is to choose a country for proper map 
projection. This is a mandatory parameter and is used to accurately represent a map in 
two-dimensional manner. 

Selecting the Country
1. Select the required country name from the Country pull-down list.

Note: If the country you require is not in the list or your choice does 
not give you the expected view of the map, please contact Oracle 
support.
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File Menu
Selecting the Map Data Files
1. Select Add File to specify the path and name of files that form the map data.

This will open the standard File Browser dialog from where you can make the appropriate 
data file selections.

Note: The data files that you select here must be in the same format 
(MIF, Shape or TAB) as that specified for the Map Data Format 
selection.

2. After making the data file selections, if you want to remove any of the selected files 
from the list, click the Delete button adjacent to the file path. 

3. Select Save to save the Data Set Configuration.

4. Select Cancel to discard all selections and go back to the master Configuration 
window.

Data Format Configuration
Data Format Configuration enables Map Editor to correctly interpret the selected data 
set(s). Data belonging to fields that are required to create a valid link for a map must be 
identified and matched to corresponding internal Map Editor link parameters.

Note: Data Format cannot be configured in the absence of valid Data 
Set(s).

Loading Associated Data Sets
1. From the master Configuration window, Select the Edit button adjacent to the Data 

Format Configuration pull-down list.

If Data Set file(s) are not configured then the Data Format Configuration will not proceed 
and an Error message similar to “Data Set needs to be loaded” will be displayed.
When the configured Data Set is loaded successfully, then the Data Format Configuration 
Dialog illustrated in the following image will be displayed.
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File Menu
Data Columns Row and Map Editor Fields Row
In this window the Data column names are displayed in the header row and the Map 
Editor field names are displayed in the first row of the table.

Matching Map Editor Fields to Data Columns
The Data columns that should to be loaded into Map Editor must be matched to the 
corresponding Map Editor fields in the Data Format Configuration window. All 
unmatched Map Editor fields are set to “Not Applicable” in this table. In the above 
picture only a single Map Editor field LinkID has been matched to the corresponding 
Data column Link_ID.

Map Editor has the following fields, out of which LinkID, NodeA_ID, NodeB_ID and 
Speed_Category are mandatory:

• RegionID

• StreetNameBase

• StreetTypeBefore

• StreetNamePrefix

• StreetNameSuffix

• StreetTypeAfter

• CityName

• Direction

• Speed_Modifier

• Distance

• Toll

• LinkID

• NodeA_ID

• NodeB_ID

• Speed_Category
Display and Controls 2-13
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File Menu
Note: The current Map Editor will not to be able to save the Data 
Format Configuration, if the mandatory fields are not set.

1. Set the mandatory Map Editor fields as illustrated in the image below:

Note: The Data Column names may vary based on different Map Data 
Providers.

Once a Map Editor field is associated with a data column, it is removed from the drop-down 
list.

Note: Map Editor is capable of generating the full street name even 
from data sets where the street names are supplied in five different data 
columns. If the data set contains a full street name, the corresponding 
data column should be matched to the Map Editor field, StreetNameBase. 

2. “Hide Not Applicable” can be enabled to display only the matched Map Editor fields

Controlling the Number of Displayed Data Rows
In the Configuration window, the first 100 rows of the map data are displayed by default. 
This number can be modified using the nRows spin button control.

1. Specify the required number of rows that must be displayed on the table by either 
typing into the nRows field or using the up and down spin button control.

2. Select Refresh to apply the change. 

Configuring the Link Travel Direction
A link connecting node A and node B in a vector map can have the following direction of 
travel:

• node A to node B

• node B to node A

• Bi-directional

• no travel allowed at all
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File Menu
 If the Map Editor field, Direction, is not associated with a Data Column, then bi-
directional travel will be allowed by default on all the loaded links.

If direction is required you must configure it, because Data Column 
values in different third party providers' maps can have different 
interpretations. To correctly configure directions you need to refer to 
the map data documentation or to the provider of that data.

1. Match the Map Editor field, Direction, to the corresponding Data column.

2. Select this column by clicking on the column header.

3. Select the Configure Direction button. It will bring up the following dialog box, where 
’?’ indicates that the direction is undefined.

Note: An empty string is a valid value that can be used to configure 
directions.

Saving the Data Format Configuration
1. Select Save from the original Data Format Configuration Window.

2. In the resulting Saving format configuration dialog, type in a new name to save the 
Data format Configuration or select an existing configuration to overwrite it with the 
new changes.

Selecting Cancel, will dismiss all the changes and take you back to the master 
Configuration window.

Filters Configuration
The Column Filters enable you to selectively display the Map Data by applying filters on 
the contents of any column.

1.  Select the Edit button adjacent to the Filters Configuration pull-down list on the master 
Configuration window.

This will display the Column Filter Configuration window illustrated in the image below
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File Menu
2. Left Click on the header of the Column whose contents you wish to filter, and see 
the Filter for column <selected column name> dialog box as shown in the picture above.

3. Select one of the following seven filter options that will be listed under the drop-
down list on the Left:

• no filtering

• matches one of

• contains one of

• starts with one of

• does not match any of

• does no contain any of

• does not start with any of

4. To match the selected filter type, type in one or more strings separated by comma (,), 
into the pattern(s) text box on the right.

5. Select Apply from the Filter for column <selected column name> dialog box to apply this 
filter on the column contents

6. Repeat steps 2 to 5 for each of the Data columns whose contents must be filtered

7. Optionally enable Show Filtered Column to display only those columns on which 
filtering is applied.

8. Optionally Modify the number of rows that are displayed on the table by specifying a 
different value in the nRows field and selecting the Refresh button.

9. Select Apply from the Column Filter Configuration window to Save the Filter 
Configuration.

10. In the resulting Saving filter configuration dialog, type in a new name to save the Filters 
Configuration or select an existing configuration to overwrite it with the new changes

Note: Only links, satisfying all the filtering criteria, will be loaded into 
the Map.

Area Configuration
The Area filter allows you to load links within a limited area. This area is defined using a 
set of (overlapping) rectangles. While the Data Set, Data Format and Filters 
configurations described in the previous sections can be created without a whole map 
being loaded into memory, the Area Configuration requires a vector-map to be loaded. 
Area can not be configured when an Oracle Real-Time Scheduler map is loaded as the 
Edit option is disabled for Oracle Real-Time Scheduler maps.
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File Menu
To proceed with an Area Configuration:

1. Select File, Edit Config from the Main Menu.

2. If the Load button is disabled on the resulting Configuration dialog, then a Vector Map 
is already loaded, else select Load to load the Vector Map using the already defined 
Data set and Data format configurations.

3. The Vector Map should now be displayed on the Map Editor display. If not, enable 
the Links display by selecting View, Links from the File menu.

4. After the Vector Map has loaded successfully, select New from the Area Configuration 
pull-down list and Click on the adjacent Edit button. 

This will bring up a blank Area Configuration dialog box similar to the one illustrated in the 
image below, containing “West”, “South”, “East” and “North” as placeholders for 
coordinates.

Identify the area on the Vector Map display that you want to configure and enclose this with 
multiple overlapping rectangles.

 

5. Left Click and Drag to draw a rectangle around the area that you want to configure. 
You can use multiple overlapping rectangles to cover the area completely while 
avoiding unwanted areas.

The Area filter Configuration dialog will display as many rows as the number of rectangles on 
the Map display area.

6. You can select a rectangle by selecting its corresponding row on the Area filter 
configuration dialog. The selected rectangle will be highlighted with a bold border on 
the Map display.

Once created the Rectangles cannot be adjusted, but can be deleted and recreated again.

7. You can optionally select Delete to remove the selected rectangle.
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File Menu
8. Finally save the Area Filter configuration and return to the master Configuration 
window by selecting Apply. 

9. In the resulting Saving area configuration dialog, type in a new name to save the Area 
Configuration or select an existing configuration to overwrite it with the new changes

The picture above shows the area configured as two overlapping rectangles. Once the 
configuration is saved, the rectangles are removed from the screen.

10. Select Save from the master configuration window to save the master configuration.

11. Reload the same Map using the saved master configuration by selecting File, Load 
from the Main Menu. 

Observe that only links within the selected area are loaded now.

Note: The Column and Area filters can be used concurrently to create a 
map of the required level of detail and area. For Example: It will be 
more resource efficient to initially load only level 1 and 2 links for the 
larger map area, create the desired area configuration using the displayed 
map image, modify the column filter and then reload the map for the 
smaller area with the required higher level of detail. 

Traffic Profiles Data Set Configuration
HERE Traffic Patterns is provided in a .csv format and represents 3 years of history of 
average road speeds. In addition, a Holiday Appendix is provided to list a country's major 
holidays and surrounding days where the traffic patterns are impacted (for example, 
Memorial day in the US is the last Monday in May and there is less traffic due to the 
absence of work-day commuting, but more traffic due to recreational travel).

Clicking Edit button next to Traffic Profiles Data Set Configuration will bring up the 
following window dialog. The configuration can be saved after Speed Profiles and Link 
Profiles are properly specified. Loading Holiday Appendix is not mandatory. Select 
Cancel at any stage to discard all selections and go back to the master Configuration 
window. 
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Loading Speed Profiles

The first step in Traffic Data Set Configuration is to choose Speed Units and Intervals. 
These are mandatory parameters and are used to read data in traffic data sets. Make sure 
that the Speed Units and Intervals you choose match the description of the files you are 
going to load.

The Speed Units can be selected from two options: KPH (kilometers per hour) and MPH 
(miles per hour), see picture below.

You can select 15 minute or 60 hours Speed intervals, see picture below.

When Speed Units and Interval are selected, finally, select Add File to specify the path and 
name of files that contain speed profiles.
Display and Controls 2-19
Oracle Real-Time Scheduler Map Editor User’s Guide



File Menu
This will open the standard File Browser dialog from where you can make the 
appropriate data file selections. User can add or remove previously added files as needed.

Attempt to save file now without adding link profiles will cause the following alert, all 
changes will be lost and user will be returned to master configuration edit. You will have 
to start over again.

Loading Link Profiles

To load Link Profiles select LinkProfiles tab and click Add File.

This will open the standard File Browser dialog from where you can make the 
appropriate data file selections. User can add or remove previously added files as needed.
Display and Controls 2-20
Oracle Real-Time Scheduler Map Editor User’s Guide



File Menu
After Link Profiles and Speed Profiles are loaded, you may save the configuration, or add 
Holiday Appendix and then save. 

Loading Holiday Appendix

Finally, you can select which holiday appendix files will need to be loaded.

Saving the Traffic Profiles Data Set Configuration

Select Save from the original Traffic Profile Data Set Configuration window. 

In the resulting Saving HERE traffic profiles data dialog, type in a new name to save the 
Configuration or select an existing configuration to overwrite it with the new changes.
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Selecting Cancel will dismiss all the changes and take you back to the master 
Configuration window.

Traffic Layers Configuration

You can configure which traffic layers will be calculated by Map Editor. Clicking Edit 
button next to Traffic Layers Configuration will bring up the following window dialog.

Here you can specify Traffic Layers and Public Holidays Specifications.

Creating Traffic Layer

To create a new Traffic Layer you should first “Add Row” and then fill in “LayerId” and 
“Layer Description”. There is only one Traffic Layer Type at the moment - “Historical 
Traffic”. After specifying ID and Description, create the layer itself by clicking button 
“Edit”. See the figure below. 
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Clicking Edit will bring up the following dialog. 

Here you should use the “Add Row” button to add first and following rows as needed 
and specify times and days, which will form this layer. You can copy and modify rows, or 
delete unnecessary rows. Once all specifications are inserted, the first layer configuration 
can be saved.

Now you can proceed to adding second layer and editing it. See picture below where we 
have two layers displayed “Morning Peak: and “Evening Peak”, where the “Evening 
Peak” layer is being edited.
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A new Layer can be added using Copy Row button in the “Map Layer Configuration” 
dialog. When a layer row is copied, the user is invited to name the new layer to be created.

As in traffic profiles data sets Save and Cancel buttons apply to the whole dialog, so 
pressing “Cancel” would reject changes for all the specifications: Traffic Layers and 
Holiday.

Public Holiday Specifications

Public Holiday Specification IDs are pre-filled from map data. 
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Holiday Specifications rows can also be added, removed or copied. The picture below 
shows added new local holiday “Local Festival” which is held on 07/12/2017, for this 
date the Sunday profile will be applied.

Map Editor does not allow to save overlapping layers specifications or layers with empty 
specifications. Map Editor will give corresponding error messages on attempt to save 
invalid Traffic Layers Configuration. For example: 
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Currently, Scheduler supports up to 10 layers, including the base layer. Therefore, Map 
Editor does not allow to save more than 9 Layers. Attempt to save more than 9 layers will 
result in the following error: 

Speed Configuration
You can configure link speeds by assigning speeds to the speed-categories associated with 
the links. Additionally, different speeds can be defined depending on the value or 
percentage stored in the “Speed modifier” field of a link. Speeds can not be configured 
until the system “knows” what the categories (and modifiers if any) are. Speed category 
and modifier lists can only be constructed by the Map Editor from the loaded map or 
previously created speed configuration file. A warning message will pop up on attempting 
to configure speed without speed categories being loaded into the system.

To proceed with a Speed Configuration:

1. Load the Map Data Set into Map Editor by selecting File, Load from the Main Menu.
From the resulting Master configuration dialog, select the required configuration 
pointing to the required Data Set and select Load from this dialog.

2. Wait for the Map data to be loaded and enable the Links display by selecting View, 
Links from the File menu

3. Invoke the Edit Current Speeds configuration dialog by selecting File, Edit Current 
Speeds from the Main Menu.

This opens a blank Speed Conversion dialog box.

In this dialog, speed categories are set in rows and speed modifiers in columns. The speed 
categories are automatically derived from the loaded vector map. You must define a speed 
modifier for each of the available speed categories. The speed configuration file can not be 
saved until speed modifiers are defined for all speed categories in the table.

4. Click on the cell adjacent to the first speed category and enter the required speed 
modifier value.

5. Repeat step 5 for each of the speed categories in the table.

6. Select Save to save this Speed configuration.

7. In the resulting Saving speed configuration dialog, type in a New name to save the Speed 
Configuration or select an existing configuration to overwrite it with the new 
changes.

8. Select Save and Apply from the Edit Current Speeds configuration window to save 
and apply the speed configuration.
Once speed configuration is applied, the map links will be redrawn using 
corresponding colors from the Map Editor speed color legend.

Note: The Speed Conversion dialog can also be invoked by selecting 
File, Load from the Main Menu to open the Master configuration and 
then by selecting the Edit button adjacent to Speed configuration pull-down 
list.
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Speed configurations created in this manner can only be applied by re-
loading the data.

Load MAL format
Map Editor can load and edit a map that was previously created in MAL format: 
individual links to be removed of modified. The resulting map can be saved in MAL or 
HIP format. 

Select File, Load MAL format from the Main Menu.

 In the resulting file browse window, locate and Open the required .mal file.

While the Map is being loaded its progress will be displayed within the Loading .mal Map 
dialog. This Length of this operation is determined by the size of the map that is being 
loaded.

An Info window similar to the one illustrated below is popped up at the end of the Map 
Loading operation. It displays the map name and the number of nodes and links that 
were created from n MAL-links.

Save MAL format
The Save MAL format option allows you to save the currently loaded map into the 
Oracle Real-Time Scheduler supported map format, MAL.

If Link Speed configuration is not supplied then the map is created using default speed.

Note: Traffic Layers can only be saved in HIP format. 

Load HIP format
Map Editor can load and edit a map that was previously created in HIP format: individual 
links to be removed of modified. The resulting map can be saved in MAL or HIP format.

Select File > Load HIP format from the Main Menu. 

In the resulting file browse window, locate and Open the required .hip file.

While the Map is being loaded its progress will be displayed within the Loading .hip Map 
dialog. This length of this operation is determined by the size of the map that is being 
loaded.

An Info window similar to the one illustrated below is popped up at the end of the Map 
Loading operation. It displays the map name and the number of nodes and links that 
were created from HIP map links.
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Save HIP format
The Save HIP format option allows you to save the currently loaded map into the Oracle 
Utilities Mobile Workforce Management supported map format, HIP. 

If Link Speed configuration or Map Traffic Profiles are not supplied then the map is 
created using default speed.

Loading Raster Map
The Load Raster option will cause a directory-selector window to appear, from which a 
directory, containing the raster map images can be selected (See section “Raster Map” on 
page 30for more information on Raster maps). Map Editor is programmed to install a 
raster map using the files listed under the specified directory. Map Editor will display an 
error message if it was unable to install a raster map from the specified directory. The 
“Load Raster Map” option will overwrite the raster map specified within the Map Editor 
configuration setup.

Note: The loaded Raster maps are displayed only if the “Raster Maps” 
option is already enabled from the “View” Menu.

Closing Raster Map
The Close Raster option will erase the currently loaded raster map from the Map Editor 
display. See section “Loading Raster Map” on page 28 for details on loading Raster maps.

Printing Map
The Print Map option allows you to print the Map Editor display. 

Quitting Map Editor
The Quit option provides the safest method to quit Map Editor.

On selecting the File > Quit option, Map Editor will exhibit either of the following two 
behavior:

• Will open the “Closing Map File” confirmation Popup-window if the map was changed since 
the last Save operation. 

• Will unconditionally close the Map Editor Application if the map has not been changed since 
the last Save operation.

Note: The unconventional method of closing the Map Editor 
Application with a Double Left Click on the Main Window Control 
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Menu icon at the top-left corner of the Main Window, carries the risk of 
loosing all unsaved changes made to a loaded Map.
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The Map Editor View Menu enables selective display of map information. These menu 
options are explained in the following sections

Zooming In / Out
Increasing or decreasing the scale of the map display can be accomplished in any of the 
following ways: 

• Selecting the View > Zoom In/Out option from the Main Menu.

• Selecting the “Zoom In”, “Zoom Out” buttons from the Tool Bar.

• Selecting Zoom In/Out option from the window local menu
OR
Pressing Shift ‘+’ and Shift ‘-’ from the keyboard to zoom in or out respectively.

The “Zoom In” option displays a smaller area of the map in a magnified form whereas 
the “Zoom Out” option displays a greater area of the map in a minimized form. The map 
distance scaling unit moves from kilometer to meter and vice versa with repetitive zoom 
in or zoom out operation.   

Reset the map
Resetting the map displays the Map with the lowest level of magnification - that is, the 
way it is displayed when the map is initially loaded up. It cannot be zoomed out any 
further after this level.

You can enable the Zoom Reset operation from:

• the Main Menu

• the Tool Bar

• the window local menu

Raster Map
Raster map displays are replicas of the paper maps or road maps. Raster maps can be 
constructed from map data available from geo-data providers in different countries. 
Please contact your Oracle Real-Time Scheduler representative for more information on 
creating raster maps for a particular region. They provide the User with better visual 
information about geographical details of a region.

Toggle On/Off
Options
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The Raster Map to be displayed on selecting the “Raster Map” option is determined 
either from the Raster map loaded from the “File > Load Raster” option (see section 
“Loading Raster Map” on page 28) or from the setting within the Map Editor 
configuration setup.

Note: A raster map display will reduce the clarity with which Map 
Editor map links will be displayed.

Greyscale

A grey scale map is nothing but a greyed out raster map (see section “Raster Map” on 
page 30 for more details on Raster Maps). Grey scale maps do not reduce the resolution 
of the overlaying map links displayed on the Map Editor display. Raster maps should be 
created and specified in Map Editor Client window configuration in order to be able to 
view grey Scale maps for a particular region. Please contact your Map Editor 
representative for further details.

_Raster/map_1.0.

Map Editor links

Raster map roads 
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Links
Map Links contain the travel information between locations and are represented by the 
straight lines joining two nodes within the map. All Links are One-Way Links, and have 
an inherent direction. The direction of a Link is from the starting Node to the ending 
Node, and can only be travelled in that direction. Two-Way Links are just two One-Way 
Links (in opposing directions) between two nodes.

The “Links” option displays only single links between nodes. Different colored Links 
illustrate different travel speeds. Also see “Speed Legend” on page 33. 

Zones
A zone is an imaginary polygon that is constructed of coordinates (usually Longitude/
Latitude) within the map space known to Map Editor. The sides of a zone polygon are 
the zone links and the link ends are the zone nodes. On enabling the Zones option, all 
existing Zones (if any) will be highlighted in the Map Editor window (see the picture 
below). The area and color of all existing Zones can be edited. Please refer section “Edit 
Zone Operations” on page 38 for more details on editing zones.

Note: Zones will be displayed only if a zone file is specified in the Map 
Editor Client configuration file.

_ZoneOption_1.0.png
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The Map Windows menu enables selective display of map information. All options under 
this menu can be toggled on or off. These menu options are explained in the following 
sections.

Speed Legend
Speed Legends make it easy to identify the road speed by the Map-link color. On 
selecting the Speed Legend option, a window as illustrated in the figure below is popped 
up. This is a non-editable window displaying colored bars representing predefined road 
speeds and corresponding Map link colors. The bar speed indicates the Map-links travel 
speed and the bar color reflects the color used to draw Map-links having corresponding 
travel speed. This window can be dismissed with a Left Click on the ’OK’ control button. 

Map Layers Info
Once Map Layers are calculated, you can invoke Map Layers Info option that allows you 
to see links speed on a particular traffic layer. On selecting the Map Layers Info option, a 
window as illustrated in the figure below is popped up. This is a non-editable window 
displaying calculated layers, when a layer is selected, map window displays colored links, 
where colors represent speeds on that layer.

_SpeedLegend_window_1.0.png
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road speed 

Red colored Map link
indicates travel speed of
61 kmph to 75 kmph on the
corresponding road. 
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To select a layer, click the desired layer and then click “Select” button. 

This window is dismissed with a click on the “Close” button.

The link speeds on layers are colored according to “Map Speed Legend” representing 
predefined road speeds and corresponding Map link colors. Note that you can select both 
“Map Speed Legend” and “Map Layers Info” options at the same time.

The two pictures below show link speeds on different layers.

Observing the coloring of links on major freeways one can see that “Night” speeds are 
clearly higher that “Morning Peak” speeds.
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The "Map Layers Info" window allows you to see time specifications that construct a 
layer. Left Double click on the selected layer will expand the layer as illustrated on the 
picture below.

On attempt to show traffic layers when Traffic Layers are not calculated (Layers can be 
configured, but not calculated) the following message will be shown. 

In this case you need to compress traffic layers by selecting “Compress Traffic Layers” in 
the Operations menu.

Info Window
The Info Window is used to display self-explanatory messages, describing a situation or 
the result of an operation in simple terms.
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Automatically Show Window
The Info Window is displayed by default whenever there is a warning message or an error 
message, unless the Automatically Show Window option is toggled off. You can open 
this window at any time to see any messages since the last Clear operation by selecting 
Windows, Info Window from the Main Menu.

Clear
This will clear all messages, but leave the Info Window on display.

Close
This will close the Info Window, but will not clear existing messages.

Link Info
The Link Info option opens the pop up window illustrated in the figure below. In this 
case, it tracks the movement of the mouse within the map window. At any time Map 
Editor detects a link nearest to the mouse cursor and displays the following details for the 
link within the "Link Info" window:

Note: The Speed Cat and Speed Mod are populated only when the 
loaded map is not in Oracle Real-Time Scheduler MAL or HIP format.

Field Description

Link A character string representing the link name.

City Name of City to which the Link belongs

Lon/Lat/X/Y Positional co-ordinates at the cursor position.

Speed Cat The Road Speed Category for the selected link

Speed Mod Speed Modifier if any, applied on the Speed Category

Speed The travel speed of the Link [units to match country (rounded 
to integer km/h)]

Time The time it will take to travel this link, based on the current 
settings

Dist The travel distance of the Link in Miles or Kilometers

Toll The Multiplier penalty which is Multiplied by the 
matrixTollFactor value in the smAuto configuration.
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The Map Options menu enables selective display of map information. All options under 
this menu can be toggled on or off. These menu options are explained in the following 
sections.

Two-directional Links
The "Two-directional Links" option displays both the links (in opposing directions, 
where applicable) between nodes. Please refer section “Links” on page 32 for more 
details on links. Enabling the "Modify Map" option will automatically enable the "Two -
directional Links" option

Auto Centre
The Map Editor display area is very small in comparison to the map area covered by a 
well magnified map. Locating a link manually within a map can be very daunting. Map 
Editor provides the "Auto Centre" option which can be enabled to automatically position 
the map such that a selected link is at the center of the display area. Please refer to the 
“Search” on page 41 for more details on selecting a link.

Modify Map
The "Modify Map" option must be enabled to be able to Select Links. The selected Links 
can then be edited, deleted or deselected. When "Modify Map" is enabled, the Map will 
automatically enable the "Two-directional Links" option and display. Please refer section 
“Links” on page 32 for more details on links.

Toggle On/Off
Options
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The Operations menu allows the User to do certain operations on the map, some of the 
operations give information about the map (for example: “Search”, "Check Duplicate 
Links", "Count Transitive Links"), while other operations will actually change the map 
(for example: "Join", "Compress:, "Compress Traffic Layers". The operations that 
change a map, cannot be undone, to restore a map to its original state you will have to 
reload it.

.

These menu options are explained below.

Edit Zone Operations
This option allows the User to create, modify or delete zones.

On selecting the “Edit Zones” option from the Operations menu a window as illustrated 
in the figure below is popped-up.

The following options and controls are provided within this window:

Option Description

Current Zone Identifies the currently active zone and facilitates alternate 
Zone -selections.

Create Zone Facilitates the creation of new zones

Edit Zone Facilitates the modification of selected zone.

Delete Zone Facilitates the deletion of selected zone.

Save Writes the newly created/modified zone data into the disk file.

_EditZones_1.0.png
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Selecting Zone 
"Current Zone" displays the currently selected zone and also provides a pull-down list of 
available zone names to select from. All zone operations are performed only on a selected 
Zone.

A zone can be selected by:

• Left Clicking the small control on the push button control adjacent to the "Current Zone" 
label as illustrated in the figure above.

• Left Clicking the required zone name from the resulting zone list pop-up window.

Create Zone
On selecting the "Create Zone" button from the window illustrated under “Edit Zone 
Operations” on page 38, a window as illustrated in the figure below is popped up.

1. Type a new zone name into the ’Zone’ name entry area.

2. The ‘Snap to existing nodes’ option can be enabled to discourage gaps between 
adjacent zone areas. With this option enabled, if a new zone node is plotted on the 
display area, mE will do either of the following:

a. Automatically reposition the new zone node, such that it snaps to the closest 
zone node (proximity between zone nodes is calculated internally by mE) 
belonging to an adjacent zone.

b. Leaves the new zone node position unchanged, If there are no other zones in its 
close proximity

3. Left Click on the ’Create’ button to create a zone with the name specified in step (1) 
or ’Cancel’ button to cancel the zone creation operation. 

4. Identify the map area that needs to be marked as a separate zone and plot the zone 
nodes (using Left Clicks) sequentially on the circumference of this area. Zone links 
are automatically drawn between the current node and the previous node.

_SelectZone_1.0.png
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5. Right Click anywhere on the map display area to create the final link between the first 
and last zone nodes.

6. Left Click on ’Save’ (see “Save” on page 41) to save the zone details or ’Close’   (see 
“Close” on page 41) to discard the details.

Zones are visible only if the ’Zones’ Option is enabled (see “Zones” on page 32).

Note: A maximum of 64 coordinate are allowed to specify a polygonal 
zone area. Additional coordinates specified will be ignored. Also a zone 
file can have a maximum of 256 entries.

Edit Zone
The area and display color of existing zones can be modified from the window illustrated 
in the figure below. This window can be invoked by Left Clicking on the "Edit Zone" 
button from the window illustrated under “Edit Zone Operations” on page 38.

The following options and controls are provided within this window:

Option Description

Zone Displays the name of the selected zone. This value cannot be 
edited.

Zone Visible This option is enabled individually for each zone. If this 
option is disabled for a zone then that zone will not be visible 
at any time except when it is the currently selected zone. This 
feature comes in handy especially when there are multiple 
overlapping zones to work with.

Color Facilitates selection of a zone display color from a range of 
different colors.

Drag connected nodes Enables two or more zone nodes that are snapped together, to 
be dragged around as a single unit. This can be done by 
enabling the option, Left Dragging the connected nodes to 
alter the zone area.

_ModifyZones_1.0.png
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In order to edit an existing zone

1. Select the zone from the window illustrated under “Edit Zone Operations” on 
page 38. See “Selecting Zone” on page 39 for details on selecting a zone.

2. Left Click the "Edit Zone" button on the window illustrated under “Edit Zone 
Operations” on page 38.

3. From the resulting window alter the zone display color and alter the zone area by 
manually dragging the zone nodes or links or by typing different Co-ordinates values.

4. Left Click on ’OK’ to accept the changes and on ’Cancel’ to reject the changes.

5. Left Click on ’Save’ (see “Save” on page 41) to save the zone details or ’Close’   (see 
“Close” on page 41) to discard the details.

Delete Zone
On selecting the "Delete Zone" button from the window illustrated under “Edit Zone 
Operations” on page 38, the currently selected zone will be deleted (see “Selecting Zone” 
on page 39 for details on selecting a zone). 

Save
This option saves the changes made to the zone file specified in the Map Editor Client 
configuration file and closes the window illustrated under “Edit Zone Operations” on 
page 38. Edits to existing zone data are updated and new zones are appended at the end 
of the zone file. If a zone file is not specified within the Map Editor Client configuration 
file, a new zone file named “zonefile” is created and all the newly created zones are 
appended to this file.

Close
Rejects all unsaved values and closes the window illustrated under “Edit Zone 
Operations” on page 38.

Search
The Search Option in the Operations menu initiates a map link search according to the 
search criteria specified for a particular search item. Only one search criteria can be 
specified at a time. Wildcards cannot be used within search criteria. The results of the 
search will be displayed in the lower half of the Link Search window. All the map links 
returned by the search are highlighted in the Map Display Area.

On selecting the "Search" option from the Operations menu a "Link Search" dialog 
window as illustrated in the below figure is displayed. The following sub sections will 
detail the features of the link search window.

Snap to existing node If enabled, snaps the point of selection on the map to the 
closest node belonging to a different zone.

Coordinates  Displays the Latitude and Longitude coordinates for each 
zone node used to construct the zone. Different values can be 
typed into these fields.

Option Description
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Specify Map data column, on which to apply the search (Search by)
The link search can be performed on one of the following four map data columns:

The map data column, on which the search must be performed should be selected from 
the "Search By" pull-down menu.

Specify the search pattern (Search String)
A search pattern must be typed into the text entry box adjacent to the "Search String" 
label (please refer to the figure illustrated under section “Search” on page 41), before 
initiating a map search operation.

Map Editor will search for the specified pattern in all instances of the map data within the 
map file (see “Specify Map data column, on which to apply the search (Search by)” on 
page 42) and return either, a list of matching links or a warning message if there are no 
matching links.

Link search patterns:

• are case insensitive.

• can be partial matches, that is searching by "Avenue" will match "Windsor Avenue".

All links returned as a result of the link search operation will be highlighted in blue (by 
default) on the map. Auto centering can be enabled to bring a link selected from the link 
search window into view at the center of the map display area.

Search Button
The "Search" button should be selected to start the search. A Left Click on the "Search" 
button will trigger Map Editor to search for the specified pattern within the specified 
map data column.

Successful Link Search
If the link search is successful then all matching links will be listed within the window as 
illustrated in the figure below.

Column Search Results

Street Name Returns all links containing matching Street Name pattern

City Name Returns all links containing matching City Name pattern

Node Ident Returns all links containing matching Node Ident pattern

Link Ident Returns all links containing matching Link Ident pattern
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All links returned by a search will be highlighted in blue by default within the map. A link 
selected from the list, returned by the search, will be highlighted in cyan by default on the 
map.

Horizontal and vertical scroll bars are automatically activated to facilitate viewing of 
details lying outside the display area of the link search window.

Unsuccessful Link Search
If the link search fails to return any matching links then a message dialog will be 
displayed. The title bar of this window is dynamically set to reflect the name of map data 
on which the unsuccessful search was performed.

Close Button
The "Close" button will unconditionally close the "Link Search" window.

Configure Button
The link data being displayed within the "Link Search" window can be configured using 
the "Configure" button. The columns displayed in the link search results display can be 
configured by resizing the column width and by adding or removing columns from the 
display. The latest configuration setup is retained after closing the Link Search window.

Left Clicking the "Configure" button will pop-up a window as illustrated in the figure 
below.

_LinkSearchResult_1.0.png
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This window consists of the following toggle buttons which can be enabled to display or 
disabled to hide, the associated link value.

Note: Link search results already displayed on the link search window 
will not reflect the newly applied configuration changes, unless the 
display is refreshed with a new search.

Configuring the Link Search Results Display
In order to apply a new configuration setup to the link search results display:

1. Left Click the "Configure" button.

2. Left Click the toggle buttons to enable/disable the associated link values.

3. Select "Apply" to save the new configuration setup. (Selecting "Cancel" will discard 
all configuration changes.)

4. Left Click the "Search" button to refresh the search results using the new 
configuration.

Join Map
For a map to be used within the Scheduler it must be fully connected, among a few other 
checks. The Map Editor provides the "Check Map" option under the Operations menu 
using which the map’s connectivity and common points are checked to ensure that the 
map will be loaded into the Scheduler. 

The connectivity check ensures that all the Nodes on a map can be reached. An error will 
be generated where there is no travel path between two groups of Nodes Link.

The map common points check ensures that there are no overlapping nodes at the same 
point.

A map loaded into Map Editor from third-party provider files can be not connected 
along region boundaries or, sometimes, within the same region. This type of 
disconnection can be fixed by joining nodes at the same location. Map Editor 2.0 
provides two types of "join" operations: join regions and join links. The first one joins all 
nodes that belong to different regions but has the same location, the second one replaces 
references to all same location nodes regardless of the region. Note: Any of these 
operations can produce duplicate links in the map. 

Toggle Link Value

Link Ident Displays the link ident

Street Name Displays the link street name if available.

City Name Displays the link city name if available.

From Node Ident Displays the ident of the node representing the start of the 
link.

To Node Ident Displays the ident number of the node representing the end of 
the link.
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Operations Menu
Check Duplicate Links
Two links are considered duplicate if they start and end at the same nodes, have same 
direction and are formed by identical poly-lines.

Select Operations, Check Duplicate Links from the Main Menu to find duplicate links 
in the Loaded map.

Duplicate links should be disabled before saving to Oracle Real-Time Scheduler format.

Progress of the selected operation is displayed in the Checking Duplicate... dialog illustrated 
below. The Cancel button in this dialog can be selected at any time to terminate the 
operation. 

The number of duplicate links (if any) are displayed at the end of the operation.

Connectivity
The connectivity check ensures that all the Nodes on a map can be reached. An error will 
be generated where there is no travel path between two groups of Nodes Link.

For the purpose of scheduling, an Oracle Real-Time Scheduler map must be completely 
connected, that means each node can be reached from any other node of the map.

The Check Connectivity option determines if the currently Loaded Map is fully 
connected or not and displays the appropriate result.

1. Select Operations, Connectivity, Check Connectivity from the Main Menu to 
determine the currently loaded map’s connectivity.

If the Map is not connected then 

2. Apply Ctrl Left Click on a link to select the link.

3. Select Operations, Connectivity, Remove Disconnected Nodes from the Main 
Menu.

All links not connected to the selected link will be removed, so that the remaining links 
form a connected map.
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Operations Menu
Compress
The compression operation changes the map and serves two purposes: reduce memory 
footprint of the output map and increase performance of route searching routines in 
scheduler. 

A vector map link consists of a number of points (a poly-line) that geographically 
represents the shape of a link. Each poly-point increases the size of the output map when 
it is stored in the Oracle Real-Time Scheduler MAL of HIP format. Often, not all poly-
points are required for the purpose of scheduling, and some of them can be removed 
from a link. 

Moreover, some links of the map, called further transitive links, can be concatenated into 
one link without losing information about routes, for example links that represent the 
same road, which do not start and end at intersections can be collapsed into one link. 

Select Operations, Compress from the Main Menu to compress the map by eliminating 
excessive poly-points and eliminating transitive links.

At the end of the operation a Compress Link dialog will display the total number 
transitional points that were removed.

The Map Compression is configured by two command line arguments "maxDist" and 
"ratio". A point X between points A and B is considered redundant if distance of normal 
from X to a straight line A-B is less than distance from A to B multiplied by "ratio", or 
less than "maxDist", whichever is less. Obviously, the larger "maxDist" and "ratio" are 
the less accurate map will be produced. The default value for "maxDist" is 10 meters, the 
default value for "ratio" is 0.2. 

Count Transitive Links
Counting transitive links does not change map, this operation is only informative. The 
number of transitional links is displayed after operation.

Note, that the operation only works on connected map. Attempt to count transitional 
links on disconnected map will give the following warning.
Display and Controls 2-46
Oracle Real-Time Scheduler Map Editor User’s Guide



Operations Menu
Compress Traffic Layers
The Traffic layers Compression operation calculates speeds for traffic layers defined by 
user (you) using link speeds provided by map data. Each Layer speed is calculated by 
averaging road-speeds provided in the map traffic data over the period of time on 
specific days that constitute the layer.

At the end of the operation a Compress Layers dialog will display number of layers and 
specifications and report the number of unique link speed patterns calculated during 
compression.
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Help Menu
Help Menu
 The Help menu consists of a single option

Option Description

About Displays the details of the Company and the Map Editor 
version being used.
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Tool Bar
Tool Bar
The buttons in the Tool Bar can generally be used as short-cuts for some of the more 
commonly used map menu bar or map window local menu operations. When the mouse 
cursor is placed over the buttons, a cue card pop-up explains the function of the button.

The buttons are activated with a Left Click.
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Zoom In                                 Increases the Map magnification

Zoom Out                              Decreases the Map magnification 

Reset                                    Resets the Map to the least magnification 

Raster Map                          Turns the Raster Map display On/Off if installed

Grey Scale                           Turns the Raster Map color On/Off

Links                                    Turns the Map Links display On/Off 

LatLong Coordinates           Opens or closes the Node-Link Info window 

Auto Centre                          Automatically positions the Map with the

Speed Legend                      Pops up the Speed Legend window

                                              selected Link at the centre of the Display area.

Print Map                              Prints the Map within the Display areaPrint Map                              Prints the Map within the Display area

                             

  Traffic Layers                          Selects which layer’s link speeds to show 
on Map
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Chapter 3
Map Editor Operations

This chapter describes Map Editor operations including: 

• Startup without the need to load a map file

• Load a map file

• Save a map file

• Select one or more links on the map

• Adjust the parameters and labels of selected link or links
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Editing a Map
Editing a Map
The Map Editor does not allow for: 

• the creation of new nodes or links on an existing map

• the removal of nodes on an existing map. 

The Map Editor does allow: 

• the creation of new maps        

• the editing of link speeds

• the editing of link toll value 

• the disabling of existing links (by setting the toll to a very large value) 

• checking maps, to make sure they are fully connected 

The following sections provide information needed to editing maps.

Load a Map
A map must be loaded into Map Editor before it can be edited. In order to load a map select 
"Load MAL format" from the "File" menu. Only unencrypted maps (that is maps with .mal 
extension) can be loaded and edited. Also see “Load MAL format” on page 27.

Enable Editing of the Map
Before a map can be modified the Map Editor must be switched into edit mode. This can be 
achieved by selecting the "Modify Map" option from the "Options" menu (see “Options Menu” 
on page 37).

Selecting the "Modify Map" option will automatically

• enable the display of two-directional links so that each actual link can be identified for editing 
(see “Two-directional Links” on page 37).

• open the node link information dialog (see “Link Info” on page 36) and

• highlight the link which is being displayed in the node link information dialog box on moving 
the mouse around on the map.

Editing a Single Link
Map Editor allows links to be edited either in a group or individually.

In order to edit map links one at a time:

1. Focus on the link by moving the mouse over it.

2. Ctrl Left Click to select the link

3. Ctrl Right Click to Invoke the link local menu.

4. Select the Modify, Enable or Disable options from the shorthand menu (see the menu 
illustrated in the figure below).
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Editing a Map
Edit operations on single links
The following operations are allowed on a selected link:

In order to deselect a selected link, focus and select the link once again.

Editing Multiple Links at Once
In order to edit multiple links simultaneously you can draw a box around all of the links that you 
want to select, or select individual links while holding the Ctrl key.

• Selected links are displayed in magenta color by default.

• After selecting the links, invoke the Map Editor Window local Menu with a Right Click 
on the map.

• Select the "Modify Map" option from the Map Editor Window local Menu. A sub menu 
as illustrated in the figure below will be displayed.

_SingleLinkEdit_Menu_1.0.pngfocussed link

CTRL+Right Click
to invoke shorthand
menu

Operation Description

Modifying link See “Modifying Links” on page 4.

Enable link See “Enabling Links” on page 5

Disable link See “Disabling Links” on page 5

_MultiLinkEdit_Menu_1.0.png
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Editing a Map
Modifying Links 
Selecting the "Modify Selected Links" option will open the Link Editor window similar to the one 
illustrated in the figure below.

The Speed and Toll values can be edited for all the selected links at once from the Link Editor 
window. Distance can only be edited, one link at a time.

Note: Once modified all the selected links will have these edited values so care 
should be taken when modifying multiple links.

Node Information
By default, the Link Editor window suppresses the display of node information. The node 
information associated with the currently selected link can be expanded by selecting the  "Show 
Nodes" check box.

_LinkEditorwithoutNode_1.0.png
Map Editor Operations 3-4
Oracle Real-Time Scheduler Map Editor User’s Guide



Editing a Map
.

The latest "Show Nodes" checkbox setting is retained after the Link Editor window is closed.

Disabling Links 
Links are disabled by setting the Toll value in the link to a very high value. If this is the only route 
between 2 locations it will still be used. But if there is any other path, regardless of the distance 
between the two locations, it will not be used by the Oracle Real-Time Scheduler scheduling 
application Planner. The Toll factor must to set to a value greater than 0, within Planner, for this 
to take effect. The highest value that can be set for Toll is 100.

Enabling Links 
This option clears the disabling of links by setting the toll factor to 0.

Undo Link Selection 
The Undo Links Selection is only available when at least one link is selected. This option will clear 
the selection so that no links are selected.

_LinkEditorwithNode_1.0.png

Expand or collapse
the display of
node information

Link

from node

to node
information 

information

information
Map Editor Operations 3-5
Oracle Real-Time Scheduler Map Editor User’s Guide



Saving and Loading Map Edits
Saving and Loading Map Edits
When new map updates are sent from the source map system, such as HERE maps or Nokia / 
NAVTEQ maps, the updates overlay the existing maps, overwriting any edits made in the Map 
Editor tool. Edited maps can be saved and reapplied onto an updated version the maps by 
following the prompts in the Save dialog. 

When a users edit maps, a dialog opens showing all of the changes as they make them. At any 
point they can be saved. If an update comes from the map supplier, the saved map can be reloaded 
by editing the map again, and loading a previously saved script to re-apply the changes.
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Appendix A
Creating ORS Maps

The output of Map Editor is a map in Oracle Real-Time Scheduler format that can be used by the 
Oracle Real-Time Scheduler scheduler. A map supplied to the scheduler must be connected, and 
can only require a limited amount of memory (300-500 Mb depending on hardware 
configuration). To produce such a map the following operations should be conducted in the 
following order: 

1. Join (Regions and/or Links).

2. Remove Disconnected Nodes.

3. Compress Map.

4. Save map into Oracle Real-Time Scheduler format. 

The first two operations are required to satisfy the first requirement for an Oracle Real-Time 
Scheduler-map. It is best first to join regions and links and only then remove any non-connected 
links (Remove Disconnected Nodes), otherwise Map Editor can remove many more links than 
required.

The third operation, map compression, reduces number of output links for Oracle Real-Time 
Scheduler maps, decreasing amount of required memory. It does not depend on the two other 
operations, but it may run faster when all not connected links are deleted.

All four operations will be done automatically by Map Editor when a user selects "Save ORS 
format" option from the "File" menu. This approach is the simplest, but it has a drawback: as 
"Remove Disconnected Nodes" algorithm requires a link to start connectivity search, Map Editor 
picks the link at random, so there is a small chance it picks a "wrong" link and the resulting map 
will not contain a required area or in the worst case will not contain any link at all. To reduce a 
chance of this to occur the Map Editor counts a number of links to be removed, and if it exceeds 
50% tries another link. If two attempts are not successful, a link will be chosen the third time and 
whatever map is produced will be saved into Oracle Real-Time Scheduler format.

To make sure Map Editor produces maps that cover the required area the user should manually 
perform "Join" and "Remove Disconnected Nodes" operations before saving to Oracle Real-Time 
Scheduler. It will give him/her an opportunity to prompt the system which link to use to start 
connectivity search.

A proper map requires link-speed to be configured, so the corresponding dialog will warn a user if 
speed categories for the map are not configured on request to save to Oracle Real-Time Scheduler 
format. But, the user will have the option to save a map where all links will have a default speed.



Appendix B
Map Editor Configuration Parameters

Configuration 
Parameter

Type Range default Description
Recommendations / 
Comments

logLevel int_range 0 .. 9 0 Sets the level of 
detail that will be 
logged for the 
process.

Ideally set to 0 and should not 
be set above level 5.

testLevel int_range 0 .. 9 NONE Sets the depth of 
testing that will be 
performed on the 
process in the test 
code. Must not be 
set to a value >0.

The test level and associated 
testing scope are listed below:
0=No optional tests
1=Consistency tests that have 
a negligible impact on 
performance.
3=Consistency tests that may 
have some impact on 
performance.
5=Consistency tests that may 
significantly alter the system’s 
performance.
Used by Oracle only. Do not 
change.
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[Vwarp=NN]      double_range NONE Vwarp, Vdate, 
Vtime and 
Vtimezone can be 
used to 
respectively set the 
virtual time and 
date, warping 
speed of processes 
and the application 
default timezone.
These parameters 
can be applied to 
all scheduler 
processes.

• "Vwarp=N" speeds 
virtual time factor N 
up. "Vwarp=-N" 
slows virtual time 
factor N down.

• Setting Vdate=15/01/
1990 will start the 
process as if the 
current system date is 
the 15th of January 
1990. This virtual date 
can be any date in the 
past or future.

• Setting Vtime=023514 
will start the process at 
02 hours 35 minutes 
and 14 seconds in the 
morning.

• Setting 
Vtimezone="Australia
/Melbourne" will set 
the application’s 
default timezone to 
the local time in 
Melbourne, Australia.

[Vdate=DDMMYYYY] int_range NONE

[Vtime=HHMMSS] int_range NONE

[Vtimezone] string NONE

NoExit boolean TRUE, 
FALSE

FALSE Set to TRUE to 
enable the process 
to continue after 
test point failures 
(or assertions).

Used by Oracle only. Do not 
change.

-shArgsEcho cmd-line echo

config string sources file for 
cmdline and 
environment

The Map Editor process reads 
the config file named on the 
command line (config=name)

-noLogStdOut boolean TRUE, 
FALSE

FALSE Set to TRUE to 
disable logging to 
standard output.

version display version 
information about 
this release

pluginDir String LIB Directory in which 
Map Editor looks 
for Plugins that 
assist with QT 
Styles and database 
drivers.

Configuration 
Parameter

Type Range default Description
Recommendations / 
Comments
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appStyle string_range WindowsX
P,Windows

Windows Defines the style 
of the application 
which controls the 
look and feel of 
Map Editor. 

The default style is Windows 
on Linux installation and 
WindowsXP on Windows 
installation.

shSStore_Reclaim_Interval time for the slicer[60]

logCompress string gzip Sets the file 
compression 
method for log 
files. 

Compression of log files is 
available only for UNIX 
installations.

-logToFile_MSG boolean TRUE, 
FALSE

FALSE Used to save logs 
to disk file.

Logs are essential for tracking 
process related issues and 
hence should always be logged 
to File.

logFilePrefix_MSG string mapEditor_MSG Used to set the 
path and prefix for 
log file(s). 

This must be a valid and 
accessible location on the disk.

 logHours_MSG int_range 1 .. 24 1 hour Sets the time span 
between each log 
file.

Log files are usually sent as 
email attachments. Setting this 
value to 1 hour will keep these 
file size to a minimum.

numLogFiles_MSG int_range  7 Sets the number of 
latest Map Editor 
log files to be 
maintained on the 
disk.

Old log files are deleted (only 
on UNIX installations). Log 
files created prior to a system 
restart are not deleted.
"Msys" must be installed for 
this parameter to be effective 
on the Windows environment.
Where possible, this value 
should be set large enough to 
cover the operational window 
without exhausting the 
system’s storage capacity.

-distInMiles boolean TRUE, 
FALSE

FALSE  Used to display 
distance either in 
miles or in 
kilometers.
TRUE = distance 
in miles
FALSE = distance 
in Kilometers

distPrecision int_range 3 Number of 
decimal digits for 
displaying 
distance/speed 

Configuration 
Parameter

Type Range default Description
Recommendations / 
Comments
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hipDefaultUTCoffset int_range Vtimezone Is the default UTC 
offset for packet 
field in (-)HHMM 
or (-)hhmmss 
format. Default is 
to use application 
default timezone

detailLabelFont string normalFont Sets the default 
font family for 
window label 

disableDblBuf boolean TRUE, 
FALSE

FALSE Disable all double 
buffering in grid 
windows

cellMargin int_range 0 .. 10 1 Sets the margin 
width, in pixels, 
around the data 
cells in table 
displays. No cell 
data (or other 
margins) can be 
drawn in this 
region.

 It provides a blank area at the 
boundary of a data cell. Also 
see 
NMC_HIGHLIGHT_MARG
IN and 
NMC_TEXT_MARGIN. 

highlightMargin int_range 0 .. 10 3 Sets the highlight 
margin width, in 
pixels, inside the 
NMC_CELLMAR
GIN.

This margin is used exclusively 
for the display of a rectangle 
that will be drawn when the 
cell is selected or highlighted.

textMargin int_range 0 .. 10 1 Sets the text 
margin width, in 
pixels, inside the 
NMC_HIGHLIG
HT_MARGIN.

This margin is used to provide 
a blank area between the data 
text and the highlight margin. 
The data text characters of the 
cell will be drawn inside this 
margin.

num_alert_messages int_range 250 Number of 
messaages stored 
in the Alert 
window

enableLayoutControl boolean TRUE, 
FALSE

FALSE enables layout 
control 

sbTimeFormat hh:mm MM dd yyyy time format for 
status bar 

largeToolButtons boolean TRUE, 
FALSE

FALSE use large toolbar 
buttons 

textToolButtons boolean TRUE, 
FALSE

FALSE put text on toolbar 
buttons 

appTitle string  NMC app title

appName string NMC app name 

Configuration 
Parameter

Type Range default Description
Recommendations / 
Comments
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mapViewerURL string " " location of the 
OracleAS 
MapViewer server

mapViewerDatasource string " " specify OracleAS 
MapViewer 
datasource to be 
used

mapViewerBasemap string " " specify OracleAS 
MapViewer 
basemap to be 
used

loadMapViewerImageDire
ct

boolean TRUE, 
FALSE

TRUE return the 
generated PNG 
image directly (not 
a link to the image) 

projection string etc/
map_projections.cfg

projection config 
file for proj/
latlong library

xOffset double_range 0.0 .. 
10000000.0

0.0 Raster maps offset 
in x direction in 
meters.

These parameters are used to 
adjust the calibration of raster 
images. They are in meters and 
will adjust ALL image 
calibrations.yOffset Raster maps offset 

in y direction in 
meters.

rmap string NULL Used to set the 
path and filename 
of a raster map file 
or the full path to 
the master file 
containing all the 
raster map data

zoneFile string  zonefile Path to zone file

mapColorDepth int_range  -1 MAP: color depth 
of icons on map

mapLabelPadding int_range  3 MAP: padding 
around route label 
text

mapBackgroundColor string AntiqueWhite MAP: background 
color on map 

nearestLinkColor string  Black MAP: selected link 
color on map

greyOffset int_range -255 .. 255 50 MAP: greyscale 
offset 

Configuration 
Parameter

Type Range default Description
Recommendations / 
Comments
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mapDatum string NONE Datum type used 
by vector map, 
required for 
calibration when 
raster and vector 
data do not match

mapOffset string [+-]x.x,[+-
]y.y

 0.0,0.0 Offsets in x and y 
direction by which 
vector map 
coordinates differs 
from raster map 

configPath string ./ config directory 
path 

areaFileName string MtdArea.DAT, 
MtdArea.dbf

The area file name 

leftAreaId string L_Area_ID, 
L_AREA_ID

The column name 
for left  area id 

rightAreaId string R_Area_ID, 
R_AREA_ID

The column name 
for right area id 

areaId string Area_ID, AREA_ID The column name 
for area id 

areaName string Area_Name, 
AREA_NAME

The column name 
for area name 

areaAdminLevel string Admin_Leve, 
ADMIN_LVL

The column name 
for area admin 
level 

areaType string Area_NameT, 
AREA_TYPE

The column name 
for area type 

areaCode1 string AreaCode_1, 
AREACODE_1

The column name 
for area code one 

areaCode2 string AreaCode_2, 
AREACODE_2

The column name 
for area code two 

altStreetFileName string AltStreets.DAT, 
AltStreets.dbf

The altstreet file 
name 

streetLinkId string Link_ID, LINK_ID The column name 
for link id of street

streetNameBase string StNm_Base, 
ST_NM_BASE

The column name 
for street base 
name in main data

streetNamePref string StNm_Pref, 
ST_NM_PREF

The column name 
for street name 
prefix

streetNameSuff string StNm_Suff, 
ST_NM_SUFF

The column name 
for street name 
suffix 

Configuration 
Parameter

Type Range default Description
Recommendations / 
Comments
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streetTypeBef string StType_Before, 
ST_TYP_BEF

The column name 
for street type 
before street name

streetTypeAft string StType_After, 
ST_TYP_AFT

The column name 
for street type after 
street name

altStreetNameBase string StNm_Base, 
ST_NM_BASE

The column name 
for alt street base 
name in main data

altStreetNamePref string StNm_Pref, 
ST_NM_PREF

The column name 
for alt street name 
prefix

altStreetNameSuff string StNm_Suff, 
ST_NM_SUFF

The column name 
for alt street name 
suffix 

altStreetTypeBef string StType_Bef, 
ST_TYP_BEF

The column name 
for alt street type 
before street name

altStreetTypeAft string StType_Aft, 
ST_TYP_AFT

The column name 
for alt street type 
after street name

refFileName string MtdRef.DAT, 
MtdRef.dbf

The reference file 
name 

refClass string Reference_, 
REF_CLASS

The column name 
for reference class

refCode string Code, CODE  The column name 
for reference code 

refDes string Descriptio, 
DESCRIPT

The column name 
for reference 
description

leftPostcode string L_PostCode, 
L_POSTCODE

The column name 
for left postcode

rightPostcode string R_PostCode, 
R_POSTCODE

The column name 
for right postcode 

leftRefAddr string Left_RefAddr, 
L_REFADDR

The column name 
for left reference 
address 

rightRefAddr string Right_RefAddr, 
R_REFADDR

The column name 
for right reference 
address

leftNRefAddr string Left_NonRefAddr, 
L_NREFADDR

The column name 
for left non-
reference address 

rightNRefAddr string Right_NonRefAddr, 
R_NREFADDR

The column name 
for right non-
reference address 

Configuration 
Parameter

Type Range default Description
Recommendations / 
Comments
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maxDist double_range 20 maximum 
deviation from the 
original when 
compressing links 
(m). 

nDataRowsDefault int_range 100 The default 
number of rows of 
data displayed 

foundLinkColor string blue found link color on 
map 

inViewLinkColor string cyan color of link 'in 
view' on map

selectedLinkColor string magenta selected link color 
on map 

selectedFoundLinkColor string green selected and found 
link color on map 

Configuration 
Parameter

Type Range default Description
Recommendations / 
Comments
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